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Answer the following questions: 

[1] The variable is a 

(a) Subset of the population. 

(b) Parameter of the population. 

(c) Relative frequency. 

(d) Characteristic of the population to be measured. 

(e) Class interval. 

[2] Which of the following is an example of a discrete variable? 

(a) The number of students taking statistics in this term at KSU. 

(b) The time to exercise daily. 

(c) Whether or not someone has a disease. 

(d) Height of certain buildings. 

(e) Level of education. 

[3] Which of the following is not an example of a discrete variable? 

(a) The number of students at the class of statistics. 

(b) The number of times a child cry in a certain day. 

(c) The time to run a certain distance. 

(d) The number of buildings in a certain street. 

(e) Number of educated persons in a family. 

[4] Which of the following is an example of a qualitative variable? 

(a) The blood pressure level. 

(b) The number of times a child brush his/her teeth. 

(c) Whether or not someone fail in an exam. 

(d) Weight of babies at birth. 

(e) The time to run a certain distance. 

[5] Which of the following is an example of a parameter? 

(a) The mean age of every one living in Saudi Arabia. 

(b)The median of glucose level for all diabetic patients. 

(c) The variance of the birth weights of all babies born in Riyadh. 

(d) All of (a) to (c). 

(e) None of (a) to (c). 

[6] Which of the following is an example of a statistic? 

(a) The mean age of all people in Saudi Arabia. 

(b) The number of children in Saudi Arabia. 

(c) The variance for the birth weights of all babies born in Riyadh. 

(d) The median glucose level for a sample of diabetic patients. 

(e) The type of disease a person has. 

[7] The continuous variable is a 

(a) Variable with a specific number of values. 

(b) Variable which can't be measured. 

(c) Variable takes on values within intervals. 

(d) Variable with no mode. 

(e) Qualitative variable. 
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[8] The width of the interval equals 

(a) The number of intervals. 

(b) The distance from the lower limit of an interval to the lower limit of the next 

one. 

(c) The distance from the lower limit of an interval to the upper limit of it. 

(d) The difference between the frequency of an interval and the frequency of the 

next one. 

(e) The relative frequency. 

[9] Which of the following is an example of a continuous variable? 

(a) The number of visitors of the clinic yesterday. 

(b) The time to finish the exam. 

(c) Whether or not the answer is true. 

(d) The number of patients suffering from a certain disease. 

(e) Level of education. 

 [10] The y-axis in the graph of the histogram may represents the  

(a) Frequency. 

(b) Relative frequency. 

(c) Either (a) or (b). 

(d) Neither (a) nor (b). 

(e) We can't say. 

[11] The discrete variable is a 

(a) Qualitative variable. 

(b) Variable with no mode. 

(c) Variable takes on values within intervals. 

(d) Variable with a specific number of values. 

(e) Variable which cannot be measured. 

[12] Which of the following is an example of a nominal variable? 

(a) Age of visitors of the clinic. 

(b) The time to finish the exam. 

(c) Whether or not the person is infected by influenza. 

(d) Weight of a sample of girls. 

(e) The number of educated patients. 

[13] The nominal variable is a  

(a) Variable with a specific number of values. 

(b) Qualitative variable which can't be ordered. 

(c) Variable takes on values within intervals. 

(d) Variable with no mode. 

(e) Quantitative variable. 

[14] Which of the following is an example of an ordinal variable? 

(a) The number of persons who are injured in accidents. 

(b) The time to finish the exam. 

(c) Whether or not the medicine is effective. 

(d) Blood type of a sample of patients. 

(e) Socio-economic level. 
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[15] The ordinal variable is a  

(a) Variable with a specific number of values. 

(b) Variable that takes on values within intervals.  

(c) Qualitative variable which can be ordered. 

(d) Variable with several modes. 

(e) Quantitative variable. 

[16] We calculate statistic instead of parameters because 

(a) Population are too large to measure the parameters. 

(b) Statistics are more popular than parameters. 

(c) Parameters are very large but statistics are small. 

(d) Statistics give more information than parameters. 

(e) We are only interested in values of statistics. 

[17] Which of the following is an example of a statistic? 

(a) The population variance. 

(b) The sample median. 

(c) The population mean. 

(d) The population mode. 

(e) None of these. 
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Introduction: 

SPSS is a Windows based program that can be used to perform data entry and 

analysis and to create tables and graphs. In this course we introduce basic necessary to 

run SPSS program (version 20). It includes how to create a data file and run 

descriptive statistics. 

Opening SPSS: 

Depending on how the computer you are working on is structured, you can 

open SPSS in one of two ways. 

1. If there is an SPSS shortcut like this  on the desktop, simply put the 

cursor on it and double click the left mouse button. 

2. Click the left mouse button on the  button on your screen, then put 

your cursor on All Programs and left click the mouse. Select SPSS Inc by 

clicking the left mouse button. 

The dialog box that appears offers choices of running the tutorial, typing in data, or 

opening an existing data source. The window behind this is the Data Editor window 

which is used to display the data from whatever file you are using. You could select 

any one of the options on the start-up dialog box and click OK, or you could simply 

hit Cancel. If you hit Cancel, you can either enter new data in the blank Data Editor 

or you could open an existing file using the File menu bar as explained later. 
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Click Cancel, and we’ll get acquainted with the layout of SPSS. 

Layout of SPSS: 

The Data Editor window has two views that can be selected from the lower 

left hand side of the screen.  

Data View is where you see the data you are using, each white row represents a case, 

and each column represents a variable. 
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Variable View is where you can specify the format of your data when you are 

creating a file or where you can check the format of a pre-existing file. The data in the 

Data Editor is saved in a file with the extension .save.  
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Name  

 Each variable name must be unique; duplication is not allowed.  

 Start with a letter. 

 Variable names cannot end with a period. 

 No spaces. 

Type  

 The basic types are numeric and string. 

 String variables may contain letters or numbers.  

 For string values a blank is considered a valid value.  

 Numeric operations on the string variables will not be allowed, e.g. finding the 

mean, variance, standard deviation, etc… 

Width  

 The number of characters SPSS will allow to be entered for the variable. 

 For a numerical value with decimals, this total width has to include a spot for 

each decimal, as well as one for the decimal point. 

Decimals 

 If more decimals have been entered or computed by SPSS, the additional 

information will be retained internally but not displayed on screen. 

 

The other most commonly used SPSS window is the SPSS Viewer window which 

displays the output from any analyses that have been run and any error messages. 

Information from the Output Viewer is saved in a file with the extension .spv. 
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SPSS Menus and Icons: 

Now, let’s review the most useful menus and icons. 

File includes all of the options you typically use in other programs, such as open, 

save, exit. Notice, that you can open or create new files of multiple types as illustrated 

in the following. 

 

Transform includes several options to change current variables. For example, you 

can change continuous variables to categorical variables, add a constant to variables, 

etc. 

Analyze includes all of the commands to carry out statistical analyses and to 

calculate descriptive statistics. 

Graphs include the commands to create various types of graphs including box plots, 

histograms, line graphs, and bar charts. 

Window can be used to select which window you want to view (i.e., Data Editor, or 

Output Viewer). 
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Exiting SPSS: 

To close SPSS, you can either left click on the close button  located on the upper 

right hand corner of the screen or select Exit from the File menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



13 106 Stat 
 

Using SPSS in Analyzing Quantitative discrete Data 

For quantitative discrete variables one can obtain the frequency distribution table, 

represent the frequencies using bar chart, calculate different descriptive statistics. 

Example 1:  

20 women were selected randomly and were asked about the number of children that 

they have. We get the following data: 

5, 2, 4, 2, 3, 2, 4, 2, 3, 1, 2, 4, 3, 2, 3, 5, 2, 4, 1, 2.  

This data will be entered vertically and we will name the variable “ Nochild”. 

To obtain the frequency table we use the following steps:  

 Analyze → Descriptive Statistics → Frequencies. 
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 The frequencies dialog box will appear, select the variable to be depicted in 

the frequency table by moving them from the left- to the right-hand box. 

 

 

 Click on OK in the frequencies dialog box. In the SPSS Output Viewer, you 

will see two tables. The first shows the number of observations (which is 20 

and that means that there are no missing observations) 

Statistics 

Nochild 

N Valid 20 

Missing 0 
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The second table is the frequency table and it lists the values of the variable “nochild” 

and the frequency of occurrence of each: 

Nochild 

  

Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1.00 2 10.0 10.0 10.0 

2.00 8 40.0 40.0 50.0 

3.00 4 20.0 20.0 70.0 

4.00 4 20.0 20.0 90.0 

5.00 2 10.0 10.0 100.0 

Total 20 100.0 100.0  

The output has five columns: 

1. The first column represent the values the variable “nochild” takes, which 

takes the value from 1 to 5, this means that the women under the study have 

number of children between one and five. 

 

2. The second column represent the frequencies, i.e. : 

Two women have one child. 

Eight women have two children. 

Four women have three children. 

Four women have four children. 

Two women have five children. 

 

3. The third column “percent” represent the percentages of the frequencies, i.e. : 

10 % women have one child. 

40 % women have two children. 

20 % women have three children. 

20 % women have four children. 

10 % women have five children. 
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4. The fourth column is the “valid percent”. In our example this column is equal 

to the “percent” column since we have no missing observation. If we have a 

missing observation for example if a women under the study refuses to give 

any information, or we were unable to reach her and ext, in this cases the 

“valid percent” column will be different than the “percent” column. 

 

5.  Finally, the fifth column is the “cumulative percent”, it represent the 

cumulative frequency percentage by adding in succession the percentage 

frequencies. 

 

Graphical analysis: 

 

To create a graph, select Analyze → Descriptive Statistics → Frequencies→ 

charts. 

This option creates bar charts, pie charts, or histograms in addition to the 

frequency table. Specify which chart you want to display by clicking on the 

Chart button. 

For discrete variables we select bar chat as follows: 
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 In the chart values dialog box, click on frequencies if we want the vertical axis 

to present the frequencies as shown in (1), click on percentages if we want the 

vertical axis to present the percentages as shown in (2). Then press continue→ 

ok.  

 
                                           (1) 

 

                                            (2) 
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Descriptive Statistics: 

 Convert large sets of data to more meaningful, easier to interpret, 

chunks or values.  

 They summarize the data.  

 Ex: mean, median, variance, and range.  

  

SPSS contains a function that will compute many of these statistics.  

 Analyze → Descriptive Statistics → Descriptive. 

 

 

 From the statistics dialog box, click on the desired statistics that you want to 

perform (e.g. mean, median, mode, standard deviation, variance, range, etc.), 

click on the Continue button then ok. 

 Central tendency (Mean, Median, Mode). 

 Dispersion (Std. deviation, Variance, Range). 

 Percentile values (Quartiles). 
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In the SPSS Output Viewer, you will see the requested statistics: 

Statistics 

Nochild 

N Valid 20 

Missing 0 

Mean 2.8000 

Median 2.5000 

Mode 2.00 

Std. Deviation 1.19649 

Variance 1.432 

Range 4.00 

Percentiles 25 2.0000 

50 2.5000 

75 4.0000 

As we can see from the table: 

The mean for the number of children is 2.8. 

The median is 2.5. 

The mode is 2. 

The standard deviation is 1.1965. 

The variance is 1.4316. 

The range is 4. 

The first quartile (The 25th percentile) is 2. 

The second quartile (The 50th percentile also known as median) is 2.5. 

The third quartile (The 75th percentile) is 4. 
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Continuous Variable 

The following table gives the hemoglobin level (in g/dl) of a sample of 45 apparently 

healthy men aged 20-24. Find the grouped frequency distribution for the data. 

17  17.1  14.6  14  16.1  15.9  16.3  14.2  16.5  

17.7  15.7  15.8  16.2  15.5  15.3  17.4  16.1  14.4  

15.9  17.3  15.3  16.4  18.3  13.9  15  15.7  16.3  

15.2  13.5  16.4  14.9  15.8  16.8  17.5  15.1  17.3  

16.2  16.3  13.7  17.8  16.7  15.9  16.1  17.4  15.8  

 

Using SPSS, enter this data and give name of the variable “Hemoglobin”, 

To make a frequency table , first we have to use the intervals of the hemoglobin level 

as follows  

13  - 13.9 , 14   - 14.9 , 15   - 15.9 , 16   - 16.9 , 17   - 17.9 , 18   - 18.9  

Then follow the steps  

Recoding into different variable: 

1. Select Transform --> Recode into different variables 

2. Move the variable into the “Input Window” 

3. Type a name for the new variable for example (“New”) 

4. Click “Changes” 

5. Click “Old and New Values” 

6. Enter the “old” value and the “new value” and click “Add”  

 7. Click Continue 

8. Click OK 

Then you will note that the new variable (“New”) have been added to the data  
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Frequency table and Chart: 

To analyze the data we need to make the frequency table as follows 

1. Select Analyze --> Descriptive Statistics --> Frequencies 

2. Move the recoded variable (New) into the “Variable(s)” window. 

3. Click “Charts” and put a checkmark next to the histogram. 

4. Click OK. 

 

The output shows the Frequency table for the” New” variable as follows: 

 

New 

 
Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1.00 3 6.7 6.7 6.7 

2.00 5 11.1 11.1 17.8 

3.00 14 31.1 31.1 48.9 

4.00 13 28.9 28.9 77.8 

5.00 9 20.0 20.0 97.8 

6.00 1 2.2 2.2 100.0 

Total 45 100.0 100.0  

 

 

The variable name “New” 
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And the Histogram chart: 

 

 

 

 

 

 

 

 

 

 

 

Statistics 

1. Select Analyze --> Descriptive Statistics --> Frequencies 

2. Move only the variable hemoglobin (the original variable) into the 

“Variable(s)” window. 

3. Click “Statistics” and put a checkmark next to mean, median, mode, 

variance and St.deviation.  

4. Click OK.  

 

 

 

 

 

 

The variable name “New” 
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The Statistics output: 

 

Statistics 

Hemoglobin 

N Valid 45 

Missing 0 

Mean 15.9622 

Median 16.1000 

Mode 15.80
a
 

Std. Deviation 1.14937 

Variance 1.321 

a. Multiple modes exist. The 

smallest value is shown 

 

 

Now answer the following: 

[1] The variable name is …………………. 

[2] The number of patients with hemoglobin level between (16 – 16.9) is…………….  

[3] The number of patients with hemoglobin level less than 15 is……………………...  

[4] The number patients with hemoglobin level more than or equal 17 is……………...  

[5] The relative frequency of patients with hemoglobin level  from 13 to 

14.9………………..  

[6] The percentage of patients with hemoglobin level from 15to 16.9 is………………  

[7] The mode is………………………. 

 

 

The variable name 

“hemoglobin” 
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Review Questions 

Q18) For a sample of women, here are the numbers of their children 

3 5 2 1 4 3 5 4 0 1 2 6 4 0 2 

Using SPSS, answer the following questions 

1. The type of the variable is 

a)qualitative b)continuous c)number d)normal e)discrete f)statistic 

 

2. The sample size 

a)5 b)15 c)3 d)2 e)4 f)0 

 

3. The number of women having 3 children 

a)2 b)3 c)5 d)15 e)1 f)6 

 

4. The percent of women having less than 4 children 

a)0.26 b)0.4 c)0.6 d)0.13 e)0.3 f)1 

 

5. The percentage of women having 5 or more children 

a)99% b)40% c)3% d)0% e)20% f)100% 

 

6. The number of women having between 2 and 5 children 

a)2 b)3 c)5 d)15 e)1 f)6 

 

7. The sample mean is 

a)3 b)6 c)7.84 d)2.8 e)2.5 f)0 

 

8. The sample median is 

a)3 b)2 c)3.5 d)7.5 e)2.5 f)1.5 

 

9. The sample mode is 

a)6 b)2,4 c)2,3,4 d)0,1,3,5 e)no mode f)5 

 

10. The sample standard deviation is 

a)166 b)3.457 c)1.364 d)1.796 e)1.859 f)1 

 

11. The coefficient of variation is 

a)18.59% b)15% c)123.42% d)150.62% e)66.39% f)100% 

 

12. The first quartile is 

a)1 b)2 c)2.5 d)3 e)5 f)0 

 

13. The value that 25% of data before is 

a)1 b)2 c)2.5 d)3 e)5 f)0 
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Q19) Suppose we measure the number of times a child has been to a doctor in the past 

month .For a sample of Saudi children age 2-6 years 

2 1 3 4 0 5 6 2 2 5 4 1 

Using SPSS , answer the following questions 

1. The type of the variable is 

a)qualitative b)continuous c)number d)normal e)discrete f)statistic 

 

2. The sample size 

a)2 b)12 c)6 d)0 e)1 f)3 

 

3. The number of children who has been to a doctor less than 3 times in the past 

month is 

a)1 b)2 c)6 d)7 e)12 f)5 

 

4. The percent of children who did not go to a doctor in the past month is 

a)0.08 b)0 c)0.2 d)0.6 e)1 f)0.12 

 

5. The sample mean is 

a)2.917 b)1.881 c)3.538 d)3 e)2 f)2.5 

 

6. The sample median is 

a)2.917 b)1.881 c)3.538 d)3 e)2 f)2.5 

 

7. The sample mode is 

a)2.917 b)1.881 c)3.538 d)3 e)2 f)2.5 

 

8. The sample standard deviation is 

a)2.917 b)1.881 c)3.538 d)3 e)2 f)2.5 

 

9. The coefficient of variation is 

a)0% b)64.49% d)15.62% e)66.39% f)100% d)10.62% 

 

10. The third quartile is 

a)2 b)2.5 c)3.5 d)4 e)4.75 f)5 

 

11. The value that 50% of data before is 

a)2 b)2.5 c)3.5 d)4 e)4.75 f)5 
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Q20) Here the weights in kg of 50 college students 

42 62 46 54 41 37 54 44 32 45 47 50 58 49 51 42 46 

37 42 39 54 39 51 58 47 64 43 48 49 48 49 61 41 40 

58 49 59 57 57 34 56 38 45 52 46 40 63 41 51 41  

Use these class intervals to obtain frequency table and answer the following questions 

31-<35    36-<40   41-<45   46-<50    51-<55   56-<60    61-<65 

1. The type of the variable is 

a)qualitative b)continuous c)number d)normal e)discrete f)statistic 

 

2. The sample size 

a)5 b)15 c)3 d)50 e)4 f)0 

 

3. The number of students have weight between 36 and 45 kg is 

a)6 b)12 c)18 d)20 e)50 f)16 

 

4. How many students have weight 51 kg or more 

a)6 b)12 c)18 d)20 e)50 f)16 

 

5. Which weight class has the lowest percentage of students 

a) 31-<35 b) 36-<40 c) 41-<45 d) 46-<50 e) 51-<55 f) 56-<60 

 

6. The probability that a student is of weight less than 40 kg is 

a)0.04 b)1 c)0.4 d)0.16 e)0.18 f)0 

 

7. The sample mean is 

a )47.50 b)47.94 c)7.97 d)0 e)63.53 f)50 

 

8. The sample median is 

a )47.50 b)47.94 c)7.97 d)0 e)63.53 f)50 

 

9. The sample mode is 

a)45 b)50 c)no mode d)30 e)41,49 f)65 

 

10. The sample standard deviation is 

a )47.50 b)47.94 c)7.97 d)0 e)63.53 f)50 

 

11. The coefficient of variation is 

a )47.50% b)16.62% c)7.97% d)0 e)63.53% f)50% 
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Chapter 1 & Chapter 2 

 الأسئلة النظري

Q21: For a sample of children with frequent toothache, we measure the number of 

times a child has been to a doctor in the last year as follows: 

5 4 3 2 1 Number of times 

3 4 8 10 15 number of children 

 

[1] The name of the variable…………………… 

[2] The type of the variable ……………………… 

[3] The sample size…………………………………. 

[4] The number of children have been to a doctor 3 times is……….. 

[5] The number of children have been to a doctor from 2 to 4 times is……….. 

[6] The relative frequency of children have been to a doctor 2 times is……….. 

[7] The percentage of children has been to a doctor less than 3 times is ……………… 

………………………… 

[8] The largest value of the variable is …………………………… 

[9] The number of times a child has been to a doctor with the highest Percentage is 

…………………………… 
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Q22: For a sample of children age 5,we obtain the following graph  

Number of bruises on body 

[1] The name of the variable is…………………… 

[2] The name of the graph is…………………… 

[3] The type of the variable ……………………… 

[4] The sample size…………………………………. 

[5] The number of children had 3 or more bruises is ……………… 

[6] The percentage of children has at most 2 bruises is……………….. 

[7] The smallest value of the variable is ………………………… 

[8] The number of bruises has the largest percentage…………….. 

[9] The mode is ……………………….. 

___________________________________________________________  

0 

2 

4 

6 

8 

10 

12 

0 1 2 3 4 
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Q23: For a sample of 60 women having children, we measure the age(in year) 

cumulative 

frequency 

Relative frequency  Frequency Age  

3 0.05 3 15 - 20 

15 ---- 12 21 - 26 

33 0.3 18 27 - 32 

50 0.283 ---- 33 - 38 

60 0.166 10 39 - 44 

60 Total 

 

Complete the table, then answer 

[1] The variable is …………………. 

[2] The number of women with age between (33 – 38) is ……………….……… 

[3] The number of women with age less than or equal 26  is …………………… 

[4] The number of women with age more than 32 is …………………………….… 

[5] The relative frequency of women with age from 21 to 38 is ………….……. 

[6] The percentage of women with age from 33 to 44 is …………………………. 

[7] The age class had the largest percentage is …………………………………… 

[8] The width of the interval is ……………………………………….. 

_____________________________________________________ 
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Q24: for the sample of 200 mothers at delivery ,we measure a certain serum level (in 

Mg/I).   

cumulative 

frequency 

Relative frequency  Frequency Time with doctor 

50 0.25 50 5 - 24 

113 0.315 63 25 - 44 

174 0.305 ---- 45 - 64 

198 ------- 24 65 - 84 

200 0.01 2 85 – 104 

200 Total 

Complete the table, then answer 

[1] The variable is …………………. 

[2] The number of mothers with time with doctor between (25-84) is 

……………….……… 

[3] The number of mothers with time with doctor less than or equal 64  is 

…………………… 

[4] The number of mothers with time with doctor more than 44 is 

…………………………….… 

[5] The relative frequency of mothers with time with doctor from 65 to 84 is 

………….……. 

[6] The percentage of mothers with time with doctor more than or equal 45  is 

…………………………. 

[7] The mode is …………………………………… 

[8] The sample size is …………………….. 

[9] The width of the interval is ……………………………………….. 

_____________________________________________________  



33 106 Stat 
 

Q25: The following graph shows the frequency distribution of pathologic tumor size 

(In cm) for a sample of cancer patient 

 

1) The name of the graph is  

(a) Bar chart             (b) histogram             (c) polygon             (d) curve 

2) The sample size is 

(a) 102                       (b) 40                            (c) 29                          (d) 110 

3) The number of cancer patient with the lowest pathologic tumor size is 

(a)  3                           (b) 11                            (c) 13                         (d) 15 

4) The percent of cancer patient with approximate level of pathologic tumor size = 2 

cm is 

(a)  18%                      (b) 16.36%                   (c) 32.72%                 (d) 50% 

5) The approximate size of pathologic tumor with the highest percentage of patients is  

(a)  3                          (b) 1                               (c) 36                         (d)110 

6) The mode takes a value near  

(a)  3                          (b) 1                               (c)36                         (d)110 

___________________________________________________________ 
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Q26: For the sample of Saudi women ,we obtain the following graph for the serum 

cholesterol level(in mmol/I) 

 

1) The name of the graph is  

(a) Bar chart             (b) histogram             (c) polygon             (d) curve 

2) The sample size is 

(a) 102                       (b) 40                            (c) 29                          (d) 100 

3) The number of women with the highest serum cholesterol level is 

(a)  82                        (b) 5                              (c) 26                         (d) 29 

4) The approximate serum cholesterol level with the lowest percentage of women is 

(a) 5.5                        (b) 4.5                            (c) 7.5                        (d) 29 

5) The relative frequency of women with the approximate serum cholesterol level of   

4.5 is  

(a)  0.083                 (b) 0.263                      (c) 0.147                    (d) 0.2 

6) The mode takes a value near  

(a) 5.5                        (b) 4.5                            (c) 7.5                        (d) 29 
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Q27: The following table gives the results of a survey to study the weights of students 

of two schools 

Standard deviation Mean weights  

6 30 School- A                 

10 60 School – B                

Determine whether the weights of students from school –A are more than the variable 

weights of students from school –B  

(a) School-A more than School-B   (b) School-B more than School-A   (c) cannot say               

___________________________________________________________  

Q28: If we measure the hemoglobin level and RBC for a sample of women 

Standard deviation Mean weights  

1.2 13.7 hemoglobin level 

0.5 4.5 RBC 

Determine which one of them is less variable? 

(a) hemoglobin level                      (b)RBC                         (c)Same variable 

__________________________________________________________                 
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Q29: For a sample of 15 women, we have the following results of the number of their 

children  

 

Range 

Percentiles  

Mode 

St. 

deviation 

 

Mean 

N  

75 50 25  missing valid 

 

6 

 

4 

 

3 

 

2 

 

4 

 

1.859 

 

2.8 

 

0 

 

15 

Number of 

children 

 

Then, 

1) The type of the variable is  

(a) qualitative                (b) continuous          (c) discrete         (d)statistic 

2) The sample mean is  

(a) 3            (b) 2.8            (c) 4           (d) 1.859         (e) 3.456     (f) 15    (h) 6 

3) The sample mode is  

(a) 3            (b) 2.8            (c) 4           (d) 1.859         (e) 3.456     (f) 15     (h) 6 

4) The sample standard deviation is  

(a) 3            (b) 2.8            (c) 4           (d) 1.859         (e) 3.456     (f) 15     (h) 6 

5) The sample variance is  

(a) 3            (b) 2.8            (c) 4           (d) 1.859         (e) 3.456     (f) 15     (h) 6 

6) The sample median is  

(a) 3            (b) 2.8            (c) 4           (d) 1.859         (e) 3.456     (f) 15     (h) 6 

7) The coefficient of variation is  

(a) 18.59%         (b) 15%            (c) 66.39%           (d) 123.42%        (e) 100%  
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Q30: We measure the number of asthma cases seen in the past months for a sample of 

hospital  

 

Median 

 

 

Mode 

 

variance 

 

Mean 

N  

missing valid 

 

20 

 

20 

 

128.94 

 

23.25 

 

0 

 

12 

number of 

asthma cases 

 

Then, 

1) The type of the variable is  

(a) qualitative                (b) continuous          (c) discrete         (d)statistic 

2) The sample mean is  

(a) 12         (b) 23.25         (c) 128.94         (d) 20        (e) 11.355      (f) 20  

3) The sample mode is  

(a) 12         (b) 23.25         (c) 128.94         (d) 20        (e) 11.355      (f) 20  

4) The sample standard deviation is  

(a) 12         (b) 23.25         (c) 128.94         (d) 20        (e) 11.355      (f) 20  

5) The sample variance is  

(a) 12         (b) 23.25         (c) 128.94         (d) 20        (e) 11.355      (f) 20  

6) The sample median is  

(a) 12         (b) 23.25         (c) 128.94         (d) 20        (e) 11.355      (f) 20  

7) The coefficient of variation is  

(a) 204.76%            (b) 48.84%              (c) 554.5%           (d) 84.82%     
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Q53: The random variable X, representing the lifespan of a certain light bulb is 

distributed normally with mean of 400 hours ,and standard deviation of 10 hours. 

1. What is the probability that a particular light bulb will last for more than 380 

hours? 

2. What is the probability that a particular light bulb will last for exactly 399 hours? 

3. What is the probability that a particular light bulb will last for between 380 and 

420 hours? 

4. The mean is …….. 

5. The variance is….. 

6. The standard deviation…….. 

Q54: The tensile of a certain type of thread is approximately normally distributed 

with standard deviation of 6.8 Kg. A sample of 20 pieces of the thread has an average 

strength of 72.8 Kg. Then  

1. A point estimate of the population mean of tensile strength µ is 

(a) 72.8           (b) 20             (c) 6.8            (d)  46.24         (e) none of these 

2. A 98% Confident interval for mean of tensile strength µ,the lower bound equal 

to: 

(a) 68.45        (b) 69.26        (c) 71.44        (d)  69.68        (e) none of these 

3. A 98% Confident interval for mean of tensile strength µ,the upper bound equal 

to: 

(a) 74.16        (b) 77.15        (c) 75.92        (d)  76.34        (e) none of these   

Q55: Suppose that we are interested in making some statistical inferences about the 

mean µ of normal population with standard deviation 2.0. Suppose that a random 

sample of size n = 49 from this population gave the sample mean 4.5 

1. The distribution of    is 

            (a) N(0,1)       (b) t(48)       (c) N(µ,(0.02857)
2
)       (d) N(µ,2.0) 
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2.  A good point estimate for µ is  

 (a) 4.5             (b) 2             (c) 2.5                   (d) 7                    (e) 1.125 

3. Assumptions is  

(a)  Normal, σ known                            (b) Normal, σ unknown 

(c)not  Normal, σ known                      (d) not Normal, σ unknown 

4. A 95% confident interval for µ is  

     (a) (3.44,5.56)  (b) (3.34,5.66) (c) (4.444, 4.556)   (d) (3.94,5.05)    (e) (3.04,5.96) 

Q56: An electronics company wanted to estimate in monthly operating expenses 

riyals (µ). Assume that the population variance equals 0.584. 

Suppose that a random sample of size 49 is taken and found that the sample mean 

equals 5.47. Find 

(1) Point estimate for µ 

(2) The distribution of    is 

(3) The assumptions? 

(4) A 90% confident interval for µ. 

Q57: In a random sample of 500 homes in a certain city, it is found that 114 are 

heated by oil. Let π be the proportion of homes in this city that are heated by oil.  

1. Find a point estimate for π.  

 

2.  Construct a 98% confidence interval for π. 
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Q58: In a study involved 1200 car drivers, it was found that 50 car drivers do not use 

seat belt.  

1. A point estimate for the proportion of car drivers who do not use seat belt is:  

(A) 50             (B) 0.0417            (C) 0.9583            (D) 1150             (E) None of these  

2. The lower limit of a 95% confidence interval of the proportion of car drivers 

not using seat belt is  

(A) 0.0322      (B) 0.0416            (C) 0 .0304           (D) –0.3500        (E) None of these  

3. The upper limit of a 95% confidence interval of the proportion of car drivers 

not using seat belt is  

(A) 0.0417      (B) 0.0530            (C) 0.0512            (D) 0.4333          (E) None of these 

 

Q59: A study was conducted to make some inferences about the proportion of female 

employees (π) in a certain hospital. A random sample gave the following data: 

Sample size  250 

Number of females 120  

 

1. Calculate a point estimate (p) for the proportion of female employees (π).  

 

2. Construct a 90% confidence interval for p.  
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Q60: A random sample of 200 students from a certain school showed that 15 students 

smoke. let π be the proportion of smokers in the school. 

1. Find a point estimate for π 

2. Find 95% confidence interval for π 

 

 

 

 

 

 

 

Q61: A researcher was interested in making some statistical inferences about the proportion of 

females (π) among the students of a certain university. A random sample of 500 students 

showed that 150 students are female.  

1.  A good point estimate for π is  

(A)  0.31  (B)  0.30  (C)  0.29  (D)  0.25  (E)  0.27  

 

2. The lower limit of a 90% confidence interval for π is  

(A)  0.2363  (B)  0.2463  (C)  0.2963  (D)  0.2063  (E)  0.2663  

 

3. The upper limit of a 90% confidence interval for π is  

(A)  0.3337  (B)  0.3137  (C)  0.3637  (D)  0.2937  (E)  0.3537  
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Appendix for chapter 5: 

The values of standard normal Z1-α/2 that used I (1-α)% confident interval 

Level of confidence Z1-α/2 

99% 2.575 

98% 2.33 

95% 1.96 

90% 1.645 

80% 1.28 

 

 


